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ject to being changed, without notice, 
in future editions. Further, to the max-
imum extent permitted by applicable 
law, Agilent disclaims all warranties, 
either express or implied, with regard 
to this manual and any information 
contained herein, including but not 
limited to the implied warranties of 
merchantability and fitness for a par-
ticular purpose. Agilent shall not be 
liable for errors or for incidental or 
consequential damages in connection 
with the furnishing, use, or perfor-
mance of this document or of any 
information contained herein. Should 
Agilent and the user have a separate 
written agreement with warranty 
terms covering the material in this 
document that conflict with these 
terms, the warranty terms in the sep-
arate agreement shall control.

Technology Licenses 

The hardware and/or software described in 
this document are furnished under a 
license and may be used or copied only in 
accordance with the terms of such license.

Restricted Rights Legend

If software is for use in the performance of 
a U.S. Government prime contract or 
subcontract, Software is delivered and 
licensed as “Commercial computer 
software” as defined in DFAR 252.227-7014 
(June 1995), or as a “commercial item” as 
defined in FAR 2.101(a) or as “Restricted 
computer software” as defined in FAR 
52.227-19 (June 1987) or any equivalent 

agency regulation or contract clause. Use, 
duplication or disclosure of Software is 
subject to Agilent Technologies’ standard 
commercial license terms, and non-DOD 
Departments and Agencies of the U.S. 
Government will receive no greater than 
Restricted Rights as defined in FAR 
52.227-19(c)(1-2) (June 1987). U.S. 
Government users will receive no greater 
than Limited Rights as defined in FAR 
52.227-14 (June 1987) or DFAR 
252.227-7015 (b)(2) (November 1995), as 
applicable in any technical data.

Safety Notices

CAUTION

A CAUTION notice denotes a haz-
ard. It calls attention to an operat-
ing procedure, practice, or the like 
that, if not correctly performed or 
adhered to, could result in damage 
to the product or loss of important 
data. Do not proceed beyond a 
CAUTION notice until the indicated 
conditions are fully understood and 
met. 

WARNING

A WARNING notice denotes a 
hazard. It calls attention to an 
operating procedure, practice, or 
the like that, if not correctly per-
formed or adhered to, could result 
in personal injury or death. Do not 
proceed beyond a WARNING 
notice until the indicated condi-
tions are fully understood and met.

See also Appendix A, “Safety Notices,” 
starting on page 59.
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90000 X-Series Oscilloscopes—At a Glance

Table 1 90000 X-Series Oscilloscope Bandwidths, Sample Rates, and Memory Depths

Analog Bandwidth Sample rate Max Memory depth

2 channel 4 channel 2 channel 4 channel 4 channel

DSAX93204A 33 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX93204A 33 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSAX92804A 28 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX92804A 28 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSAX92504A 25 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX92504A 25 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSAX92004A 20 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX92004A 20 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSAX91604A 16 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX91604A 16 GHz 16 GHz 80 GS/s 40 GS/s 2 Gpts

DSAX91304A 13 GHz 13 GHz 80 GS/s 40 GS/s 2 Gpts

DSO/MSOX91304A 13 GHz 13 GHz 80 GS/s 40 GS/s 2 Gpts
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Ease of use with high performance

The Agilent Technologies Infiniium oscilloscopes combine unprecedented 
ease- of use with high- performance digitizing oscilloscope functionality to 
simplify your design and analysis measurement tasks.

• Traditional oscilloscope front- panel interface provides direct access to 
the controls needed for most troubleshooting tasks.

• Graphical user interface with menus, windows, dialog boxes, and 
toolbars provides easy access to dozens of configuration and analysis 
tools, ensuring you can set up and make the most complex 
measurements.

• Models with bandwidths from 13 GHz to 33 GHz.

• MSO models provide 10 GS/s at 16 channels and 20 GS/s at 8 channels.

Display shows waveforms and graphical user interface

• Graphical interface allows direct interaction with waveforms, including 
drag- and- drop positioning and instant waveform zoom.

• Touchscreen display allows oscilloscope operation without an external 
pointing device.

• Waveforms displayed in color, making correlation easy.

• Current configuration parameters displayed near the waveform display 
and are colorcoded to make identification easy.

• Graphical interface menus and toolbars simplify complex measurement 
setups.

Horizontal controls set sweep speed and position

• Intensified waveforms on main sweep window make it easy to see what 
will appear in the zoom window.

Acquisition and general controls start and stop the oscilloscope and do basic 
setup

• Run and stop controls for continuous or single acquisitions.

• Clear display before one or more acquisitions.

• Default setup and Autoscale set initial configuration.

Hard disk drive and USB 2.0 port for saving and restoring setups and 
measurement results

• Store measurement displays for inclusion in reports and test setup 
guides.

• Store oscilloscope setups to repeat tests another time.

• Hard disk stores oscilloscope operating system.
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Trigger setup controls set mode and basic parameters

• Select Edge, Glitch, or Advanced Modes.

• Choose input source and slope.

• Use graphical user interface to simplify configuration of pattern, state, 
delay, and violation trigger modes.

• Use auxiliary trigger to increase triggering flexibility.

Vertical controls set attenuation and position

• Color- coded knobs make it easy to find the controls that affect each 
waveform.

Marker and quick measurements help measure waveform parameters

• Waveform markers A and B to check voltage or Δ- time at any point on 
the displayed waveform.
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In This Book

This book gives you the information you need to begin using the Infiniium 
90000 X- Series oscilloscopes. It contains three chapters, two appendixes, 
and an index:

Chapter 1, “Setting Up the Oscilloscope,” starting on page 11 contains 
inspection, power requirements, air flow, and setup information.

Chapter 2, “Using the Oscilloscope,” starting on page 25 gives an overview 
of the front and back panel inputs and outputs, front- panel controls, and 
graphical user interface, and tells you how to perform basic operations 
with the oscilloscope.

Chapter 3, “Using the Online Help,” starting on page 55 describes the 
Infiniium oscilloscope application’s online help contents and navigation. 
The online help describes how to use the Infiniium oscilloscope application 
in detail.

Appendix A provides safety notices. 

Appendix B provides recommendations for working comfortably and safely 
while operating the Infiniium oscilloscope.

For More Information

• For detailed information on how the oscilloscope makes measurements 
and how to use the oscilloscope, see the Infiniium oscilloscope 
application’s online help.

• For information on controlling the oscilloscope from a remote computer, 
see the Oscilloscopes Programmer’s Reference found in the Infiniium 
oscilloscope application’s online help.

• For information on testing and servicing the oscilloscope, see the 
Service Guide manual found in the Infiniium oscilloscope application’s 
online help.
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This chapter shows you how to set up your Infiniium oscilloscope, connect 
power and accessories, and verify general operation.
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1 Setting Up the Oscilloscope
 

Inspecting package contents

✔ Inspect the shipping container for damage.

• Keep the shipping container or cushioning material until you have 
inspected the contents of the shipment for completeness and have 
checked the oscilloscope mechanically and electrically.

• If the shipping container is damaged, or the cushioning materials 
show signs of stress, notify the carrier and your Agilent Technologies 
Sales Office. Keep the shipping materials for the carrier’s inspection. 
The Agilent Technologies Sales Office will arrange for repair or 
replacement at Agilent’s option without waiting for claim settlement.

✔ Inspect the oscilloscope.

If there is mechanical damage or a defect, or if the oscilloscope does 
not operate properly or does not pass performance tests, notify your 
Agilent Technologies Sales Office.

✔ Verify that you received the following items in the Infiniium oscilloscope 
packaging.

• Infiniium oscilloscope
• Power cord
• Keyboard
• Mouse (USB optical)
• Touchscreen stylus
• Accessory pouch
• Front panel cover
• Calibration cable
• Connector saver collars (kit of 10)
• Connector assembly, 3.5mm f- f (quantity of 5)
• ESD wrist strap
• Quick Start Guide
• Digital channels cable (MSO models only)
• MSO calibrator board assembly (MSO models only)

If anything is missing, contact your nearest Agilent Technologies Sales 
Office. If the shipment was damaged, or the cushioning materials show 
signs of stress, contact the carrier and your Agilent Technologies Sales 
Office.

✔ Verify that you received the options and accessories you ordered and 
that none were damaged.

For a complete list of options and accessories available for the 
90000 X- Series oscilloscopes, see the Infiniium 90000 X- Series 
Oscilloscopes Data Sheet.

http://cp.literature.agilent.com/litweb/pdf/5990-9712EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5990-9712EN.pdf
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Environmental conditions

Table 2 90000 X-Series Oscilloscope Environmental Characteristics

Environment Indoor use only.

Temperature Operating: 5 °C to + 40 °C
Non-operating: –40°C to +65 °C

Humidity Operating: up to 95% relative humidity (non-condensing) at +40 °C
Non-operating: up to 90% relative humidity at +65 °C

Altitude Operating: up to 4,000 meters (12,000 feet)
Non-operating: up to 15,300 meters (50,000 feet)

Vibration Operating random: 00.21 g(rms)
Non-operating random: 2.0 g(rms)
Swept sines: (0.50g)

Installation/ Measurement 
Category

Installation category: 2
Measurement category: 1

Power 100-240 V, 47-63 Hz; 800 W for 4-channel models.
100-240 V, 50 Hz; 100-208 V, 50/60 Hz; 800 W for 8-channel models

Weight 45.1 lbs (20.5 kg)

Dimensions 10.5 in. wide (27 cm), 16.75 in. tall (43 cm), and 18.7 in. deep (48 cm)

Safety Meets IEC 61010-1 +A2, CSA certified to C22.2 No. 1010.1, 
self-certified to UL 3111

Voltage Fluctuations Note that the mains supply voltage fluctuations are not to exceed 
+/-10% of the nominal supply voltage.

Pollution Degree The Infiniium 90000 X-Series oscilloscopes may be operated in 
environments of Pollution Degree 2.

Pollution Degree 
Definitions

Pollution Degree 1: No pollution or only dry, non-conductive pollution occurs. 
The pollution has no influence. Example: A clean room or climate controlled 
office environment.
Pollution Degree 2. Normally only dry non-conductive pollution occurs. 
Occasionally a temporary conductivity caused by condensation may occur. 
Example: General indoor environment.
Pollution Degree 3: Conductive pollution occurs, or dry, non-conductive 
pollution occurs which becomes conductive due to condensation which is 
expected. Example: Sheltered outdoor environment.
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1 Setting Up the Oscilloscope
 

Positioning for proper airflow

1 Position the oscilloscope where it will have sufficient clearance for 
airflow around the top, back, and sides.

Figure 1 Positioning the 90000 X-Series Oscilloscope with Sufficient Clearance

Minimum 0 mm

Minimum 0 mm

Front panel of oscilloscope

Minimum 100 mm Minimum 100 mm

Minimum 39 mm

Top View

Rear Panel

CAUTION Do not place the oscilloscope side-by-side with other instruments blowing warm air. 
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Connecting the mouse, keyboard, LAN cable, and MSO cable

Mouse and
Keyboard

A mouse and keyboard can be plugged into either USB host ports or the 
PS/2 ports.

There are several USB host ports on the back and front panel of the 
oscilloscope that can be used. (The USB device port is used for remote 
control of the oscilloscope from a PC.)

When using the PS/2 ports, the mouse and/or keyboard must be plugged 
in prior to turning on power to the oscilloscope.

LAN Cable Connect your LAN cable to the RJ- 45 connector on the back panel of the 
oscilloscope.

MSO Cable If the oscilloscope is an MSO model, connect the digital channels cable to 
the MSO connector, making sure to orient the cable as shown on the 
drawing on the back panel.

NOTE After you have connected to the LAN card, you must set up the network. Before you try to 
set up your network, you should exit the oscilloscope application.

If you do not know how to set up a network in the Windows 7 operating system, see your 
network administrator or use the Windows 7 operating system’s online help.

Figure 2 Back Panel
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1 Setting Up the Oscilloscope
 

Connecting power

1 Connect the power cord to the rear of the oscilloscope, then to a 
suitable AC voltage source.

Power Supply Protection Features

The Infiniium 90000 X- Series oscilloscope’s power supply has built- in 
protection features for over- voltage, over- current, and over- temperature 
fault conditions.

Green LEDs for AC and DC indicate normal operation. A red Fault LED 
indicates a fault condition.

When a fault occurs (and the power supply shuts down), you must unplug 
the power cord, wait 10 to 30 seconds, and plug the power cord back in to 
reset the protection latch and allow the oscilloscope to be powered on 
again.

If the power supply has overheated, you may need to wait longer so it can 
cool before you can power on the oscilloscope again.

Table 3 Power Requirements

Power 100 - 240 VAC at 50/60 Hz
Input power 800 Watts

CAUTION Use only power cords designed for your oscilloscope.

The line cord provided is matched by Agilent to the country of origin of the order.

WARNING To avoid electric shock, be sure the oscilloscope is properly grounded.

NOTE Note that the oscilloscope’s power supply has a built-in safety feature that, after the 
oscilloscope is turned off, requires the oscilloscope to remain off for about 10 seconds 
before it is turned back on.
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Connecting oscilloscope probes

The Infiniium 90000 X- Series oscilloscope channel 1- 4 inputs have:

• 3.5 mm threaded RF connectors (like Agilent sampling oscilloscopes) to 
ensure the most reliable signal integrity.

• A convenient automatic torque mechanism that ensures a consistent 
8 in- lbs connection.

• An AutoProbe II interface connector with pins that provide probe 
power, identification, and other communication signals.

The AutoProbe II interface works with the InfiniiMax III probing system. 
There are four different InfiniiMax III probe amplifiers ranging from 16 to 
30 GHz. For more information, see Agilent InfiniiMax III Probing System 
Data Sheet.

Before using the InfiniiMax III probes, review the InfiniiMax III Probe 
Handling Guide included with the probes. These probes are ESD sensitive 
devices and there is a proper order for connecting probe amplifiers to the 
oscilloscope, probe heads to the device under test (DUT), and probe heads 
to the amplifier. You can also find the InfiniiMax III Probe Handling 
Guide on the Agilent web site (www.agilent.com) or with other Agilent 
oscilloscope probes documentation in the Probe Resource Center 
(www.agilent.com/find/prc).

The N5442A Precision BNC 50 Ω adapter lets you use the InfiniiMax II 
probing system with the 90000 X- Series oscilloscopes.

CAUTION Do not exceed the maximum input voltage rating.

Oscilloscope channels 1-4 are rated for maximum input of ±5V including transients.

Figure 3 90000 X-Series Oscilloscope Probe Connectors

http://cp.literature.agilent.com/litweb/pdf/5990-5653EN.pdf
http://cp.literature.agilent.com/litweb/pdf/5990-5653EN.pdf
http://www.agilent.com
http://www.agilent.com/find/prc
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1 Setting Up the Oscilloscope
 

Connecting threaded RF cables

You can connect 3.5 mm threaded RF cables to the Infiniium 
90000 X- Series oscilloscope inputs using the automatic torque “clutch” 
mechanism to ensure a consistent 8 in- lbs connection.

The Aux Out and Cal Out connectors also work with 3.5 mm threaded RF 
cables.

Tilting the oscilloscope for easier viewing

Tabs under the oscilloscope's front feet can be flipped out to tilt the 
oscilloscope.

Figure 4  Flip-Out Tabs Under Front Feet
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Turning on the oscilloscope

1 Press the power switch in the lower left corner of the oscilloscope front 
panel.

After a short initialization period, the oscilloscope display appears. The 
oscilloscope is ready to use.

2 You can connect and disconnect probes and cables while the 
oscilloscope is turned on.

NOTE The first time you turn on the oscilloscope, you must have a mouse connected to accept the 
Microsoft end-user license agreement for the Windows 7 operating system.

Figure 5 Turning on the Oscilloscope
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1 Setting Up the Oscilloscope
 

Verifying basic oscilloscope operation

1 Install the supplied connector savers to each channel input. Agilent 
recommends using the connector savers to protect the input connectors.

2 Connect one end of the 54916- 61626 calibration cable to oscilloscope 
input channel 1.

3 Connect the other end of the calibration cable to the Cal Out connector 
on the front panel.

4 Press the [Default Setup] key on the front panel.

The display will pause momentarily while the oscilloscope is configured 
to its default settings.

5 Press the [Auto Scale] key on the front panel.

The display will pause momentarily while the oscilloscope adjusts the 
time/div setting and vertical scale. You should then see a square wave 
with about four cycles on screen and a peak- to- peak amplitude of 
approximately 4 divisions.

Figure 6 Verifying Basic Oscilloscope Operation
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If you do not see the waveform, make sure your power source is 
adequate, the oscilloscope is properly powered on, and the probe is 
connected securely to the front- panel channel input and to the probe 
calibration output.

6 Move the mouse around the mouse surface and verify that the 
on- screen pointer follows the mouse movement.

7 Touch the pointer of the touch screen stylus to the surface of the 
screen and move it around while verifying that the pointer follows the 
movement.

Installing application programs on Infiniium

Infiniium has an open Windows operating system, which lets you install 
your own application software. Agilent has verified that the following 
applications are compatible with the Infiniium oscilloscope application.

• Agilent Vector Signal Analysis

• Agilent VEE Pro

• Microsoft Office

• MathWorks MATLAB

• Mathsoft MathCad 2001i

• McAfee VirusScan

• Symantec Norton AntiVirus

If you install an application other than those Agilent has tested, it is 
possible that it could break the oscilloscope application. This would 
potentially require you to recover the oscilloscope hard drive.

NOTE Exit the oscilloscope application before installing any software.
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1 Setting Up the Oscilloscope
 

Changing Windows Operating System Settings

Many Windows operating system settings can be changed to suit your own 
personal preferences. However, some operating system settings should not 
be changed because doing so would interfere with the proper operation of 
the oscilloscope.

• Do not change the Power Options.

• Do not change the System Properties Hardware Tab settings.

• Do not change the Regional and Language Options Advanced Tab 
settings.

• Do not remove Fonts.

• Regarding Display Settings:

• Do not change the screen resolution from 1024 by 768 pixels or the 
color quality from Highest (32 bit).

• Do not change the Font size to Extra Large.

• Do not use a Menu font size greater than 14 points.

• Do not use the Administrative Tools to enable or disable Internet 
Information Services (Web Server). Use the Infiniium Web Control dialog 
box to enable or disable the Web Server.

• Do not delete or modify the Infiniium Administrator user account.

NOTE Exit the oscilloscope application before changing any Windows operating system settings 
outside of the oscilloscope application.
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Turning off the oscilloscope

1 Press the power switch at the lower left corner of the oscilloscope front 
panel. The oscilloscope will go through a normal Windows operating 
system shutdown process.

Cleaning the oscilloscope

Clean the oscilloscope with a soft cloth dampened with a mild soap and 
water solution.

CAUTION Do not use too much liquid in cleaning the oscilloscope. Water can enter the 
Infiniium front panel, damaging sensitive electronic components.
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1 Setting Up the Oscilloscope
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This chapter describes how to use the Infiniium 90000 X- Series 
oscilloscope’s inputs and outputs, front- panel controls, and graphical user 
interface.

• The familiar front- panel oscilloscope interface with knobs and keys is 
optimized for common tasks and basic measurements. 

• The Infiniium oscilloscope application’s graphical interface with menus, 
windows, dialog boxes, and toolbars provides easy logical access to 
dozens of configuration and analysis tools, making it easy for you to set 
up and make the most complex measurements. 

• You have the option of using either the front panel controls or the 
graphical user interface for many common tasks.
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2 Using the Oscilloscope
 

Front Panel Inputs and Outputs

On the Infiniium 90000 X- Series oscilloscopes, the channel inputs and the 
Aux Out and Cal Out outputs appear on the lower part of the front panel. 
The ground plug, probe compensation terminal, and three USB host ports 
are also located here.

Channel Inputs

The four channel inputs have:

• 3.5 mm threaded RF connectors.

• A convenient automatic torque mechanism.

• An AutoProbe II interface connector with pins that provide probe 
power, identification, and other communication signals.

The AutoProbe II interface works with the InfiniiMax III probing system. 
See “Connecting oscilloscope probes" on page 17.

You can also connect 3.5 mm threaded RF cables to the channel inputs.

Ground

The ground plug is convenient for ESD wrist straps.

Aux Out

This output signal is selected by the Infiniium oscilloscope application's 
Calibration Output dialog box. It can be a DC level, the probe 
compensation signal (a square wave used to adjust compensated passive 
probes), the trigger out signal, or a demo signal.

Cal Out

This calibration output is used when performing user calibration on the 
oscilloscope.

A calibration cable is included with the oscilloscope. 

Figure 7 Infiniium 90000 X-Series Oscilloscope Front Panel I/O
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You can also use the Infiniium oscilloscope application’s Calibration 
Output dialog box (Utilities > Calibration Output) to select other output signals, 
just like you can for the Aux Out output.

Probe Compensation Terminal

This terminal has a square wave signal that is used to adjust compensated 
passive probes. Be sure to use an N5449A high- impedance adapter.

You can also output a DC level on this terminal using the Infiniium 
oscilloscope application's Calibration Output dialog box.

USB Host Ports

There are three USB host ports on the right side of the front panel.
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2 Using the Oscilloscope
 

Back Panel Inputs and Outputs

The Infiniium 90000 X- Series oscilloscope’s back panel has the 
motherboard I/O connectors, a USB device port, reference clock 
synchronization connectors, and BNC connectors. MSO models include an 
MSO connector.

Motherboard I/O

These are the inputs/outputs/ports provided by the motherboard in the 
oscilloscope: PS/2 mouse and keyboard connectors, external monitor 
connectors, serial interface, USB host ports, LAN port, speaker and 
microphone connectors, etc.

USB Device Port

The back panel USB device port can be used for remote control of the 
oscilloscope from a PC.

Figure 8 Infiniium 90000 X-Series Oscilloscope Back Panel I/O



Using the Oscilloscope 2

Agilent Infiniium 90000 X-Series Oscilloscopes User’s Guide 29

 

10 MHz In, 10 MHz Out

The 10 MHz In BNC connector is used to synchronize the oscilloscope's 
horizontal timebase system to a reference clock that you provide. The 
clock that you provide must meet the following specifications:

• Amplitude: 178 mV peak to 1 V peak.

• Frequency: 10 MHz ±5 ppm high- quality sine wave or square wave.

To use an external reference clock, connect the external clock to the 
10 MHz In BNC connector; then, in the Infiniium oscilloscope application's 
Horizontal Setup dialog box (Setup > Horizontal), enable the 10 MHz External 
Reference Clock.

You can use the 10 MHz Out BNC connector to send the oscilloscope’s 
10 MHz reference clock output signal to another instrument’s reference 
clock input.

Trig Out

Pulses corresponding to oscilloscope triggers can be sent to this BNC 
output.

Aux Trig

You can set up the oscilloscope to trigger on the auxiliary trigger signal 
connected to this BNC input.

Digital Channels Connector

MSO models include a connector for digital channel inputs. 

CAUTION Be sure to orient the cable as shown in the drawing on the back panel. 
Inserting the cable incorrectly could bend the pins or cause errors.
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Front Panel Controls (Keys and Knobs) Overview

The Infiniium 90000 X- Series oscilloscope front panel gives you direct 
access to the functions needed to perform the most common 
measurements, using a traditional oscilloscope interface. Knobs and keys 
let you directly set vertical and horizontal parameters. The front panel 
also has a set of LED (Light- Emitting Diode) indicators; by using these 
and the display, you see the oscilloscope’s configuration at a glance.

The oscilloscope uses color consistently throughout the front panel and 
user interface. For example, the color of the knob for channel 1 is the 
same color as the waveform for channel 1. All the configuration items and 
values related to channel 1 are displayed in the same color.

Figure 9 Infiniium 90000 X-Series Oscilloscope Front Panel
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Graphical User Interface Overview

With the graphical interface for the Infiniium oscilloscope, you can access 
all the configuration and measurement features of the oscilloscope through 
an easy- to- use system of menus, toolbars, dialog boxes, icons, and buttons.

The graphical interface is arranged so the most common functions 
affecting the waveform display are located around the edge of the 
waveform viewing area. 

Right- click menus pop up to provide quick access to commands and 
configuration items that relate only to the context of the graphical 
interface item in which they are found. These context- sensitive menus are 
available when you right- click in the memory bar, waveform display area, 
measurement toolbar, and horizontal and acquisition control regions. 

The following three figures call out the areas and controls of the graphical 
interface. 

Figure 10 Infiniium Oscilloscope Top of Display
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The waveform display area shows the waveforms and, optionally, the 
results of your measurements. Several display options, including a grid, are 
available. You can use the mouse to click and drag waveforms to new 
vertical or horizontal positions. You can also click and drag a rectangular 
area on the display, then click the Waveform Zoom menu item to zoom on 
that section of displayed waveform.

Ground reference indicators show channels, waveform memories, and 
functions for each waveform that is on. The symbol represents the ground 
reference point for each channel; it moves when you change the vertical 
offset. You can also drag this symbol up and down to change the vertical 
offset for that waveform.

Figure 11 Infiniium Oscilloscope Waveform Display Area
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Ground reference 
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NOTE Avoid Overdriving Vertical Input Amplifiers

When zooming on a waveform with the oscilloscope running, be careful to keep the signal 
within the screen vertically to avoid overdriving the vertical input amplifiers. Overdriving 
causes waveform distortion and erroneous measurement results. 
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The tab display area in the very bottom of the display shows information 
and statistics for the selected tab. The type of markers shown in the 
waveform display area depend on the tab you have selected.

Depending on your settings, the tabs can show measurement results, mask 
test results, and vertical and horizontal scale and offset. You can even 
navigate through a serial data stream. If you have the optional EZJIT+ 
Jitter Analysis software, a Jitter tab shows the RJ DJ jitter measurement 
statistics.

Figure 12 Infiniium Oscilloscope Bottom of Display
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Menu Overview

Menus are a part of the graphical user interface. You can use them to 
perform defined operations, set up measurement parameters, and access 
every function the oscilloscope provides. 
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Figure 13 Infiniium Oscilloscope Menus

Look through the menus to get an overview of the many features and 
capabilities of your Infiniium oscilloscope. For example, the Demos menu 
selections include various demos that illustrate features of the scope. 
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Setting the Oscilloscope to a Known Starting Condition

You can set up the oscilloscope for many different kinds of complex 
measurements.

• To automatically configure the oscilloscope for the current input 
signal(s), press the [Auto Scale] key or select Control > Autoscale from the 
menu bar.

• To reset the oscilloscope to its default setup, press the [Default Setup] 
key or choose Control > Default Setup.

• If you use the [Default Setup] key with the graphical interface enabled, 
you can choose Control > Undo Default Setup to return the oscilloscope to 
its original configuration.

Figure 14 Setup Control Keys

NOTE Save the Current Oscilloscope Configuration

Before using [Default Setup], you may want to save the current oscilloscope configuration 
for later use. See the online help (described in chapter 3) for instructions on saving and 
recalling setups, and for information on the exact configuration that is set when you press 
[Default Setup].
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Starting and Stopping Waveform Acquisitions

Use the acquisition run controls to run and stop acquisitions or make a 
single acquisition. The highlighted area of the memory bar above the 
waveform display area shows how much of acquisition memory is 
displayed on the screen. 

The [Run/Stop] key is lit green and the blue- green Run button is 
highlighted when the oscilloscope is running (acquiring data). The 
[Run/Stop] key is red and the Stop button is highlighted when the 
acquisition is stopped. 

• To start waveform acquisition, press the [Run/Stop] key or click the Run 
button.

The oscilloscope begins acquiring data. When it receives a trigger signal, 
it finishes acquiring data, updates the display, and then starts another 
acquisition cycle if it is in Trig’d or Auto trigger mode.

• To stop waveform acquisition, press the [Run/Stop] key or click the Stop 
button.

The oscilloscope stops acquiring data. Whatever data was last acquired 
remains on the screen.

• To make a single acquisition, press the [Single] key or click the Single 
button.

The [Single] key is lit yellow and the Single button is highlighted while 
the acquisition takes place.

• You can also choose the Run, Stop, and Single commands from the 
Control menu.

• To set up how you want the signals to be sampled, such as sampling 
rate and mode, choose Setup > Acquisition.

Figure 15 Front Panel Acquisition Run Control Keys

Figure 16 GUI Acquisition Run Control Buttons

Run Stop Single
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Adjusting the Horizontal Time Scale and Trigger Position

Use the horizontal controls to configure the oscilloscope’s horizontal scale 
(time per division) and horizontal position of the waveform. You can also 
view a magnified section of the waveform using the zoom window.

You can use the horizontal scale and position knobs, the horizontal GUI 
controls, or the Horizontal Setup dialog box to adjust the horizontal scale 
and position.

Adjusting the horizontal scale

• To stretch the waveform horizontally, turn the horizontal scale knob 
clockwise. To shrink it horizontally, turn the knob counter- clockwise.

The horizontal scale knob is the larger of the two horizontal control 
knobs. It is marked with a set of sine wave symbols. Stretching the 
waveform means there are fewer seconds displayed per division. 
Shrinking the waveform means there are more seconds displayed per 
division.

Push the horizontal scale knob to change the scaling in finer (Vernier) 
increments.

Figure 17 Horizontal Scale and Position Knobs, [Zoom] key

Figure 18 Horizontal GUI Controls
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• You can also use the controls in the horizontal and trigger toolbar to 
adjust the horizontal scale. Click the horizontal scale field to display a 
pop- up numeric keypad that lets you set a particular horizontal scale.

• Or, you can use the two icons to the right. The left (smaller) icon 
shrinks the waveform, which decreases the horizontal scale and 
increases the time per division. The right icon stretches the waveform, 
which increases the horizontal scale and decreases the time per 
division.

Adjusting the horizontal trigger position (delay)

• To move the waveform to the right, turn the horizontal position knob 
clockwise. To move the waveform to the left, turn the knob 
counter- clockwise.

Moving the waveform to the right shows more of the pre- trigger data 
(data acquired before the trigger event). Moving the waveform to the 
left shows more of the post- trigger data (data acquired after the trigger 
event).

The horizontal position knob is the smaller of the two horizontal 
control knobs. It is marked with a set of arrows. There is a momentary 
pause at zero while you are turning the knob. Continuing to turn the 
knob will move the horizontal position through zero.

• When you click and drag the desired waveform, the horizontal position 
will change for all channels and functions on the display, but the 
waveform memories will not change.

• You can also use the controls in the horizontal and trigger toolbar to 
adjust the horizontal position. Click the horizontal position field to 
display a pop- up numeric keypad that lets you set a particular 
horizontal position (time relative to the trigger at the highlighted 
horizontal reference point). Or, you can use the three icons to the right. 
The left arrow moves the waveform to the left, the center “0” resets the 
horizontal position (delay) to zero, and the right arrow moves the 
waveform to the right.

Magnifying a part of the waveform using Zoom

• To turn on zoom, press the [Zoom] key.

The waveform display area splits into two regions. The top one is the 
main timebase. The bottom is the zoomed timebase, which represents 
an expansion of the acquired waveform data. A section of the waveform 
in the main sweep window is highlighted to indicate the part shown in 
the delayed sweep window.
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The horizontal scale and horizontal position controls now change how 
the waveform is shown in the delayed sweep window. The horizontal 
scale will change the amount of magnification, while the position will 
change the part of the waveform in the main window that is shown in 
the zoomed window.

• Press the [Zoom] key again to turn it off.

Setting the horizontal reference point

• Click one of the three vertical arrows in the horizontal and trigger 
toolbar to set the horizontal position to the respective horizontal 
reference position on the display – left, center, or right. Assuming the 
horizontal position is at zero, left means the information on the display 
is post- trigger; center means the information to the left of center is 
pre- trigger and to the right is post- trigger; and right means the 
information is pre- trigger.

• A non- zero horizontal position value is the time relative to the trigger 
event at the selected horizontal reference point.

Using the Horizontal Setup dialog box

• You can use the Horizontal Setup dialog box to set scale, position, and 
the horizontal reference. You can also set up the delayed time base 
window, which presents a magnified view of an area of the waveform.

To access the Horizontal Setup dialog box, click the  in the 
Horizontal and Trigger toolbar, or choose Setup > Horizontal from the 
menu.
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Adjusting the Vertical Settings

Use the vertical controls to set the vertical scaling (volts per division) and 
vertical offset for each analog channel. You can also turn the display on or 
off for a particular channel.

Figure 19 Channel Keys and Vertical Scale and Offset Knobs

Figure 20 GUI Vertical Controls
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Turning an analog channel on or off

• To turn an analog channel on or off, press the channel number key or 
click the check box next to the channel number. When you turn off a 
channel, the current vertical scaling factor and scale buttons for that 
channel disappear.

If you are not using a particular analog channel, you can turn it off to 
simplify the waveform display and increase the display update rate. 
While an analog channel is turned off, data acquisition continues for 
that channel. Therefore, you can still use the analog channel as a source 
for functions.

Adjusting the analog channel’s vertical scale and offset

• You can use the vertical scale and offset knobs, the vertical GUI 
controls, or the Channel Setup dialog box to adjust the vertical scale 
and offset. 

• To make the waveform bigger (fewer volts per division), turn the 
vertical scale knob clockwise. To make it smaller (more volts per 
division), turn the knob counter- clockwise.

The vertical scale knob is the larger of the two knobs for a channel. It 
is marked with a set of sine wave symbols. Decreasing the vertical scale 
makes the waveform bigger, with fewer volts displayed per division. 
Increasing the vertical scale makes the waveform smaller, with more 
volts displayed per division.

• You can also click in the vertical scaling field to open a pop- up 
numeric keypad that lets you set an exact value for the scaling. Click 
the two icons next to the field to make the waveform bigger or smaller. 

• To move the waveform toward the top of the display, turn the vertical 
offset knob clockwise. To move it toward the bottom of the display, turn 
the knob counter- clockwise. The vertical offset knob is the smaller of 
the two knobs for a channel. It is marked with a set of arrows.

• You can click and drag the ground reference indicator for the waveform 
you want to move to the desired offset.

• Choose Setup > Channel N from the menu bar or click a channel number 
to open the Channel Setup dialog box, in which you can set the vertical 
scaling, offset, skew, and labels. You can also specify the characteristics 
of a probe, or perform a probe calibration.

NOTE Using an Analog Channel as External Trigger

Any analog channel can be used as a trigger source. If you need an external trigger but do 
not need all analog channels, you can use an analog channel as an external trigger without 
displaying it by turning the analog channel display off.
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For Agilent Technologies probes that are compatible with AutoProbe II 
interfaces, the oscilloscope will automatically set these characteristics 
(except for skew) after identifying the probe when it is connected to the 
channel input.

Turning digital channels on or off

• To turn the digital channels on, click the check box next to the  at 
the right end of the toolbar.

Controlling digital channels

• If your oscilloscope is an MSO model, press the  button to open the 
Digital Setup dialog box so you can control the digital thresholds and 
four digital buses, enable active channels, turn on signal names, and 
change the vertical height of digital channels.
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Setting Up Triggers

Use the trigger controls to set the conditions on which the oscilloscope 
will trigger and acquire an input signal. You can set up a variety of trigger 
conditions. Edge triggers and the parameters for edge triggering can be set 
up from the front panel.

Trigger configuration settings you make using the graphical interface are 
reflected in the front- panel status indicators, and will remain set unless 
you change them (either using the front panel or the graphical interface) 
or press the [Default Setup] key. 

Setting the oscilloscope to trigger on an edge

1 Press the [Source] key until the desired source LED is illuminated.

You can choose any of the channels or the Aux Trig or Line input as the 
source for an edge trigger.

2 Press the [Slope] key until the desired slope LED is illuminated.

You can have an edge trigger on a rising or falling edge.

Figure 21 Trigger Controls and Indicators

Figure 22 Trigger GUI Controls

Set trigger level

Open the Trigger Setup 
dialog box

Select the trigger source

Select rising or falling
edge for the trigger

Select Auto or Trig’d

Set trigger sensitivity

Open the Trigger 
Setup dialog box

Set 
trigger 
level



Using the Oscilloscope 2

Agilent Infiniium 90000 X-Series Oscilloscopes User’s Guide 45

 

3 Press the [Sweep] key until the Trig’d or Auto (select one) LED is lit.

When Trig’d is selected, the oscilloscope must find the trigger before 
saving and displaying captured data.

When Auto is selected, if a trigger does not occur within a certain 
amount of time, an acquisition is automatically saved and displayed. In 
Auto trigger mode, you are able to see your signals while setting up the 
desired trigger.

4 Turn the Level knob to adjust the voltage level at which the 
oscilloscope will trigger.

Use the Trigger Setup dialog box to select any of the different modes of 
triggering, the parameters and conditions for each trigger mode, and 
advanced configuration items.

You can also click in the Set Trigger Level field to open a pop- up numeric 
keypad so you can set a particular trigger level when the scope is set for 
edge trigger on a particular channel. You can also use the up and down 
arrows to the right of the setting, or click and drag the trigger reference 
indicator at the right side of the display.
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Using Markers and Making a Measurement

With the measurement controls you can display and adjust markers, define 
a key to perform automatic measurements or perform other quick actions, 
and make measurements.

Making a measurement on a waveform

• Click and drag a measurement icon to the waveform event you want to 
measure, or click a measurement icon and specify which source you 
want to measure in the dialog box that appears.

For measurements on waveform features, such as those that involve 
waveform edges, if you click the measurement icon and specify a 
source, the measurement defaults to using the feature closest to the 

Figure 23 Measure Controls

Figure 24 GUI Measurement Toolbar
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horizontal reference point. When you make the measurement using 
drag- and- drop, the measurement uses the waveform feature closest to 
the point where you drop the icon.

The most commonly used measurements are available on the toolbar. 
Others are available by selecting them from the Measure menu.

When you drag and drop a measurement icon on a waveform, the icon 
outline changes color to match the color of each waveform it touches so 
you can easily see which waveform will be measured when you release. 
The measurement results are also displayed in color so you can easily 
see which waveform source is being measured.

For edge- sensitive measurements, when you drop the measurement icon 
on a waveform, a geometric icon appears in the waveform marker color. 
This icon shows exactly where the measurement is being made. The 
icon is also displayed next to the measurement results readout to 
associate the readout with the waveform and feature being measured. 

This feature helps you distinguish measurement results from each other 
when you make multiple measurements on the same waveform, but at 
different waveform features. For example, a series of rise time 
measurements on several different edges of the same waveform all have 
unique geometric icons to show each measurement’s location. See 
Figure 25. 
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Using quick measurements

• You can define the [Multi Purpose] key to perform one of these quick 
actions:

• QuickMeas — performs automatic measurements

• QuickPrint — prints the screen image to the default printer

• QuickScreen — saves the screen image to a file

• QuickSetup — loads a setup file

• QuickWaveform — saves waveform data to a file

• QuickE- mail — sends and e- mail of the current screen image

• QuickExecute — runs an executable file

• QuickControl — cycles through the possible front panel control 
sources

Figure 25 Waveform Measurements
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The action taken when the [Multi Purpose] key is pressed depends on the 
feature selected in the Customize Multipurpose dialog box. The default 
feature is QuickMeas (quick measurements).

• To turn on the quick measurement display, press the [Multi Purpose] key.

The five preset measurements defined in the Quick Measurement 
configuration are enabled and results are displayed on the screen for 
the first waveform source. The factory default measurements are: Vp- p, 
Period, Frequency, Rise time, and Fall time.

• To measure parameters for another waveform, press the [Multi Purpose] 
key until that waveform is the one shown in the measurement readout.

Continuing to press the [Multi Purpose] key cycles through each of the 
waveforms available.

• To turn off the quick measurement display, press and release the 
[Multi Purpose] key until the measurements are turned off.

The measurement results disappear from the screen.

See the Infiniium oscilloscope application’s online help for information on 
how to configure the quick measurement capability, using the Customize 
Measurement feature of the graphical interface.

Using markers

Markers make it easier to make precise measurements because the marker 
measurement readouts show exact voltage and time positions for the 
markers. The measurements are based on actual waveform data from the 
acquisition system, not on approximations based on the display position, 
so you can be sure the values are highly accurate.

Using the marker and measurement controls, you control two sets of 
markers within the oscilloscope graticule. You use markers to make more 
accurate measurements of waveform events than you could make visually.

Both time and voltage differences between the markers are updated 
continuously on the screen. By default, the markers track the source 
waveform. Voltage measurements from the markers are the value of the 
waveform at the time set with the marker arrow keys.

• To select the type of marker mode you want to use, press the [Markers] 
key and select the mode in the pop- up dialog box. Do not close the 
dialog box.

• To turn on Marker A, push the Position knob until the marker you want 
to move appears in the pop- up dialog box.

Marker A has a solid line pattern on the waveform display. It is 
associated with the first available source on the display.
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• To turn on Marker B, push the Position knob until the marker you want 
to move appears in the pop- up dialog box.

Marker B has a dashed line pattern on the waveform display. It is 
associated with the first available source on the display.

• To move a marker, turn the Position knob.

In Measurement Marker mode, the marker position cannot be changed.

Moving markers using the graphical interface

1 Turn on the markers either by pressing the [Markers] key on the front 
panel or by choosing Measure > Markers.

2 Click and drag one of the markers to the position you want on the 
waveform, then release.

Clicking and dragging a marker makes it easy to quickly move the 
marker to the desired waveform event. You can use the front- panel 
Position knob for fine adjustment, or choose the Markers command 
from the Measure menu and set the marker position precisely.
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Controlling the Display

You can set the display to suit your preferences, such as by enabling the 
touch screen or adjusting the intensity of the displayed waveform.

Enabling or disabling the touch screen

• Press the [Touch] key. 

• Or, choose Setup > Display to open the Display Setup dialog box and click 
the Touch Screen check box.

Clearing the waveform display

• Press the [Clear Display] key or press the Clear Display button.

The oscilloscope clears acquired waveform data from the display in 
preparation for another acquisition. If the oscilloscope is in Run mode 
and is receiving triggers, it will update the display as it collects new 
waveform data.

Clearing the waveform display also resets averaging, infinite persistence, 
color grade persistence, histograms, and the mask testing database.

Adjusting the brightness of the displayed waveform

• Turn the Intensity knob or press the Waveform Brightness button.

Figure 26 Display Control Keys and Knob

Figure 27 GUI Display Control Buttons

Clear the waveform 
display

Change the waveform 
brightness



52 Agilent Infiniium 90000 X-Series Oscilloscopes User’s Guide

2 Using the Oscilloscope
 

Saving and Printing Data

• Choose File > Save from the menu bar to save your setup, composite, 
waveform, screen, or measurement data.

• Press the Print Screen button in the Horizontal and Trigger toolbar to 
print the screen to the default printer configuration selected in the 
Windows Control Panel.

• Choose File > Print from the menu bar to print waveform and setup data 
to a specified file.

• You can also customize the [Multi Purpose] key to perform a QuickPrint.
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Forcing a Default Setup

If your Infiniium oscilloscope is not working properly when you start it up 
and pressing [Default Setup] does not fix the problem, follow these steps to 
force a default setup and return the Infiniium to normal operation.

1 Turn off the Infiniium.

2 Turn on the Infiniium. If the oscilloscope does not successfully restart 
then try recycling the power again.

3 After the Windows 7 load screen disappears, press the [Default Setup] 
key on the front panel. If the oscilloscope still does not successfully 
restart, follow the instructions for recovering the hard drive.

Infiniium Hard Drive Recovery

Follow these steps to recover your Infiniium hard drive.

1 Turn off the Infiniium.

2 Connect the keyboard to the keyboard connector on the rear panel of 
the oscilloscope.

3 Connect the mouse to the mouse connector on the rear panel of the 
oscilloscope.

4 Turn on the Infiniium.

5 When you see the message press F2 to boot the Infiniium Recovery 
System, press F2 and follow the on- screen instructions.

6 Once the recovery process is finished and the oscilloscope is running, 
check in the About Infiniium dialog box under installed options to see 
if all of the options you ordered are installed. If the options are not 
installed, please install them using the license keys provided on the 
oscilloscope option license certificates you received, or refer to the rear 
panel of the oscilloscope.
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Most of the information about using the Infiniium oscilloscope is included 
in the online help.

The online help is accessible from the menu bar and from dialog boxes. 
This chapter explains how to use the help to find the information you 
need to use the oscilloscope effectively.

Accessing the online help

• Select Contents from the Help menu.

The Using the Oscilloscope topic appears on the home page. It looks like 
the following figure.

Figure 28 Help Menu
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The online help provides several ways to find the information you need.

With the Contents tab you can browse topics in the help system by 
clicking topics in the left pane.

With the Index tab you can type in a keyword and search the index for 
that keyword or scroll through the list to find a topic.

With the Search tab you can type in a keyword and if that word exists in 
the online help, a list of topics containing the keyword appears.

With the Favorites tab you can add preferred help topics to a list for easy 
referral.

Figure 29 Online Help Home Page
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Hyperlinks throughout the online help allow you to reach the information 
you need. Most hyperlinks are in blue underlined text, but some 
hyperlinks also have buttons (many of the reference topics) or tabs (in 
setup guide topics). You can find out whether an item has a hyperlink by 
pointing to it; if it is a hyperlink, the pointer will change to a hand icon. 
Clicking once will make a new topic appear.

Navigating through the online help

Once you are in an online help window, you may need to navigate to find 
the information you need.

For most topics:

• To display information for another topic or category described in a 
hyperlink, click that hyperlink or the button icon next to it.

• To return to the previously visited topic, click the Back button near the 
top of the Help window.

Accessing context-sensitive information

• To see overview information for items in a dialog box, click the Help 
button in that dialog box.

Figure 30 GUI Help Buttons for Context-Sensitive Help

Click here to display 
the Trigger Setup 
help topic
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This apparatus has been designed and tested in accordance with 
UL 61010- 1:2004 2nd Edition, and has been supplied in a safe condition. 
This is a Safety Class I instrument (provided with terminal for protective 
earthing). Before applying power, verify that the correct safety precautions 
are taken (see the following warnings). In addition, note the external 
markings on the instrument that are described under "Safety Symbols."

Warnings

• The mains plug shall be inserted only in a socket outlet provided with 
a protective earth contact. You must not negate the protective action by 
using an extension cord (power cable) without a protective conductor 
(grounding). Grounding one conductor of a two- conductor outlet is not 
sufficient protection.

• Whenever it is likely that the ground protection is impaired, you must 
make the instrument inoperative and secure it against any unintended 
operation.

• Capacitors inside the instrument may retain a charge even if the 
instrument is disconnected from its source of supply.

• Do not operate the instrument in the presence of flammable gasses or 
fumes. Operation of any electrical instrument in such an environment 
constitutes a definite safety hazard.

• Do not use the instrument in a manner not specified by the 
manufacturer, or the protection provided by the equipment may be 
impaired.
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Safety Symbols

Instruction manual symbol: the product is marked with this 
symbol when it is necessary for you to refer to the instruction 
manual in order to protect against damage to the product.

Hazardous voltage symbol.

Frame or chassis terminal symbol: Used to indicate a circuit 
common connected to grounded chassis.
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To optimize your comfort and productivity, it is important that you set up 
your work area correctly and use your Infiniium oscilloscope properly. 
With that in mind, we have developed some setup and use 
recommendations for you to follow based on established ergonomic 
principles.

Improper and prolonged use of keyboards and input devices are among 
those tasks that have been associated with repetitive strain injury (RSI) to 
soft tissues in the hands and arms. If you experience discomfort or pain 
while using the oscilloscope, discontinue use immediately and consult your 
physician as soon as possible. For more information on RSI, read the 
“About Repetitive Strain Injury” section, next.

Please study the recommendations offered here in this chapter. Included 
are references to relevant parts of international standards, regulations, and 
guidelines, such as ISO 9241 and the European Community Display Screen 
Equipment directive. You may also consult your employer’s human 
resources department or other relevant departments for guidance specific 
to your company.
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About Repetitive Strain Injury

Because your comfort and safety are our primary concern, we strongly 
recommend that you use the Infiniium oscilloscope in accordance with 
established ergonomic principles and recommendations. Scientific 
literature suggests that there may be a relationship between injury to soft 
tissues—especially in the hands and arms—and prolonged improper use of 
keyboards or other equipment requiring repeated motions of the hands 
and forearms. This literature also suggests that many other risk factors 
may increase the chance of such injury, commonly called Repetitive Strain 
Injury.

What is RSI?

Repetitive Strain Injury (RSI—also known as cumulative trauma disorder or 
repetitive motion injury) is a type of injury where soft tissues in the body, 
such as muscles, nerves, or tendons, become irritated or inflamed. RSI has 
been a reported problem for those who perform repetitive tasks such as 
assembly line work, meatpacking, sewing, playing musical instruments, and 
computer work. RSI also has been observed in those who frequently 
engage in activities such as carpentry, knitting, housework, gardening, 
tennis, windsurfing, and lifting children.

What causes RSI?

The specific causes of RSI have not been established. Nevertheless, the 
incidence of RSI has been associated with a variety of risk factors, 
including:

• Too many uninterrupted repetitions of an activity or motion

• Performing an activity in an awkward or unnatural posture

• Maintaining static posture for prolonged periods

• Failing to take frequent short breaks

• Other environmental and psychosocial factors

In addition, there have been reports associating the occurrence of RSI 
with the use of keyboards, mice, and other input devices. Also, certain 
medical conditions, such as rheumatoid arthritis, obesity, and diabetes, 
may predispose some people to this type of injury.

What if I experience discomfort?

If you are experiencing any discomfort, seek professional medical advice 
immediately. Typically, the earlier a problem is diagnosed and treated, the 
easier it is to resolve.
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Mice and Other Input Devices

Various aspects of using mice and other input devices may increase your 
risk of discomfort or injury. Observing the following recommendations may 
reduce that risk.

• Try to keep your hand, wrist, and forearm in a neutral position while 
using your mouse or other input device.

• If you use your thumb to rotate the ball on a trackball or spaceball, 
keep it in a relaxed, natural shape, and maintain a neutral posture in 
your hand, wrist, and forearm.

• Hold the mouse gently by draping your fingers over it. Keep your hand 
relaxed and fingers loose. Do not grip the mouse tightly.

• It takes very little pressure or force from your fingers to activate the 
buttons or scroll wheel on your mouse, scrolling mouse, trackball, or 
other input device. Using too much force can place unnecessary stress 
on the tendons and muscles in your hands, wrists, and forearms.

• If you are using a scrolling mouse, be sure to keep your fingers and 
hand in a relaxed, neutral position when activating the scroll wheel. 
Also, this type of mouse features software that can minimize the 
number of mouse movements or button clicks.

• When using a mouse, trackball, or other input device, position it as 
close to the keyboard as possible, and keep it at the same level so you 
do not have to stretch while using it.

• Be sure to keep your mouse and trackball clean. Regular removal of 
accumulated dust and dirt helps ensure proper tracking and reduces 
unnecessary hand and wrist motions.
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Index

A

accessing
index, 56
online help, 55

accessories
and options, 12

acquisition
starting and stopping, 37

adjusting
analog channel’s vertical offset, 42
analog channel’s vertical scaling, 42

airflow requirements, 14
application software, 21
associating measurement results with 

waveforms, 46
Auto Scale key, 36
Autoscale, 20

B

buttons, 30
as hyperlink, 57
help, 57

C

calibration
output, 20

cautions
cleaning, 23

channel keys, 42
channels

turning on or off analog channels, 42
checking the oscilloscope, 12
cleaning the oscilloscope, 23
Clear Display key, 51
clearing the display, 51
color

use of, 30, 46
configuration

default, 20
edge trigger, 44

configuring
quick measurements, 48

connecting
LAN card, 15
MSO cable, 15
pointing device, 15
power, 16
probes, 17

contents
online help, 55

contents topic, 55
context-sensitive

information, 57
coupling

trigger input, 44
customizing display layout, 46
cycling

markers through channels, 49
measurements through channels, 48

D

default setup, 20
Default Setup key, 36
disk

hard disk recovery, 53
display

clearing, 51
display layout

customizing, 46
display update rate

increasing, 42
drag-and-drop measurements, 46

E

edge trigger
setting, 44

erasing the display, 51

F

finding information, 55, 57
front panel

connections, 17
interface, 25, 30

G

graphical interface, 25

H

hard disk
recovery, 53

help
button, 57

horizontal
zoomed timebase, 39

horizontal position
in zoom mode, 39

hyperlinks, 57

index, 56
using to find information, 57

I

icons
measurement, 46

increasing display update rate, 42
index

accessing, 56
information

methods for accessing, 55
inspecting the oscilloscope, 12
installing

application software, 21

K

keys, 30
analog channel, 42
Auto Scale, 36
Clear Display, 51
Default Setup, 36
Markers, 49
Mode, 44
Multi Purpose, 48
Run, 37
Sensitivity, 44
Single, 37
Slope, 44
Source, 44
Stop, 37
Sweep, 44
Touch, 51
Zoom, 39

knobs, 30
analog channel’s vertical offset, 42
analog channel’s vertical scaling, 42
trigger level, 44

L

LAN card, 15
LED indicators, 30
level

trigger, 44
line voltage, 16

M

magnifying
a section of the waveform, 39
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main timebase, 39
making

measurements, 46
quick measurements, 48
waveform bigger or smaller, 42

markers
and measurements, 46
moving, 50
positioning, 49
turning on or off, 49

measurement results
associating with waveform, 46

measurement toolbar, 46
measurements, 46

and markers, 46
quick, 48
using markers, 49, 50

methods for accessing information, 55
Mode key, 44
mouse

connecting, 15
verifying, 20

moving
markers, 49, 50
waveform vertically, 42

MSO cable, 15
Multi Purpose key, 48

N

navigating the online help, 57
notes

online help access, 55, 57
online help windows, 56
zooming, 32

notices, 2

O

offset
adjusting analog channels, 42

online help
accessing, 55
context-sensitive, 57
index, 56
navigating, 57
overview, 55
windows, 56

opening the online help, 55
options

and accessories, 12
oscilloscope

cleaning, 23
inspecting, 12
using, 25

oscilloscope front panel, 30
oscilloscope operation

verifying, 20
oscilloscope probes, see probes
oscilloscope won’t power on, 16
overdriving vertical amplifiers, 32

P

pointing device
connecting, 15
verifying operation, 20

pollution degree, 13
pollution degree, definitions, 13
position

adjusting analog channel’s vertical, 42
positioning markers, 49
power

connecting, 16
requirements, 16
turning off, 23

power supply protection features, 16
preset measurements, 48
probes

connecting, 17
probing a circuit, 17

Q

quick measurements, 48

R

Repetitive Strain Injury, 61, 62
using the mouse, 63

RJ-45 connector, 15
LAN card, 15

RSI, 61, 62
using the mouse, 63

Run key, 37

S

safety
notices, 59
symbols, 60

scaling
adjusting analog channel’s vertical, 42

seconds per division
in zoom mode, 39

Sensitivity key, 44
setting

edge trigger, 44
setup

default, 20
Single key, 37
slope

trigger, 44
Slope key, 44
source

trigger, 44
Source key, 44
starting and stopping acquisition, 37
status indicators

trigger, 44
Stop

key, 37
sweep

key, 44
triggered, 44

symbols, safety, 60

T

tabs
as hyperlink, 57

toolbars
measurement, 46

topics
contents, 55
navigating, 57

Touch key, 51
tracking waveforms

using markers, 49
trigger

input coupling, 44
level, 44
setting edge, 44
slope, 44
source, 44
status indicators, 44

triggered sweep, 44
turning analog channels on or off, 42
turning markers on and off, 49

U

use of color in interface, 30, 46
user interface

front panel, 30
use of color, 30

user interface elements, 57
using

hyperlinks, 57
markers, 49
oscilloscope, 25

V

verifying basic operation, 20
vertical inputs

overdriving, 32
vertical offset

adjusting analog channels, 42
vertical scaling

adjusting analog channels, 42
volts per division

adjusting, 42

W

warnings, 59
waveform

magnifying, 39
waveform features

measurements on, 46
moving markers to, 50

waveforms
acquiring, 37
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associating with measurement results, 46
drag-and-drop measurements on, 46
making quick measurements, 48
measuring using markers, 49
turning off, 42

window
zoom, 39

windows
online help, 56

Windows operating system settings, 22

Z

zoom display, 39
Zoom key, 39
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